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1 Introduction 
 

VINcoSIM, developed by Vincotech, is a comprehensive web-based power module 

simulator tool that helps customers identify the best power module for their application. 

The tool has been expanded to include a new feature that lets customers download 

Vincotech power module characteristics data in a PLECS-compatible format. 

PLECS, the multi-domain simulation platform for power electronic systems developed by 

PLEXIM, lets users model and simulate comprehensive electrical systems, including power 

sources, converters, and loads. Simulating an entire application with proper control in 

PLECS requires an electrical and thermal model of the power module and topology circuit 

in PLECS format. 

In addition to its existing library elements, Vincotech has created a library of power-

module-optimized PLECS topology models to simplify the workflow for building 

electrothermal simulations in PLECS that use Vincotech power modules.  

This document guides readers through setting up and simulating Vincotech power modules 

in the PLECS simulation environment. 

 

2 Modeling Power Modules in PLECS 
 

Modeling power modules involves decomposing them into electrically functional topologies, 

which include semiconductor devices, such as transistors and diodes, and their 

interconnections. Each of these functional topologies transforms electrical energy from one 

form to another with an efficiency determined by the converter application parameters 

and the semiconductor operating characteristics. The primary objective of power module 

converter design is to optimize the application to maximize efficiency while meeting 

expectations in terms of reliability and lifetime. Power electronics design engineers rely on 

simulation tools to calculate the efficiency, losses and device junction temperatures of 

power converter systems and their constituent elements.  

In this effort, the efficiency and loss calculation of the power module – a key component 

of the power converter – is crucial. To accurately calculate these parameters, both the 

topology model of the power module and the characteristics of the semiconductors and 

their packaging are essential. 
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3 Modeling Power Module Topology 
 

Power modules incorporate multiple semiconductors in various combinations, resulting in 

complex electrical circuits. They typically integrate various power conversion stages, such 

as AC/DC, DC/DC, and DC/AC, within a single package. 

 

Figure 1: A typical power module topology including three conversion stages. 

 

Despite their complexity, power converter circuits can be decomposed into so-called 

functional topology elements, each responsible for a given power conversion task. For 

example, the power module circuit represented in Figure 1 can be split into three distinct 

functional topologies: a three-phase rectifier, a brake chopper, and a three-phase 

two-level (voltage-source) inverter (Sixpack).  

 

                               

Figure 2: Three-phase rectifier    Figure 3: Brake chopper  Figure 4: Sixpack 
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When calculating their electrical efficiency and losses, these functional topologies can be 

handled individually with proper excitations. The results for each functional topology can 

then be used to calculate the efficiency of the power module as a whole.   

 

The primary advantage of functional topology modeling is that it significantly reduces the 

time required to prepare simulations by relying on reusable building blocks. These can be 

used in any combination to reconstruct a power module’s electrical circuit, simply requiring 

the addition of connection wires between the functional blocks. Moreover, model selection 

depends on the functional topologies and not on the individual transistors or diodes, 

reducing simulation preparation time. 

 

 

Figure 5: Reconstructing the power module circuit by adding connection wires between individual 

functional topologies. 
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4 A PLECS Library of Functional Topologies 
 

Vincotech has assembled a PLECS library of individual functional topologies that customers 

can use to reconstruct power modules. These functional topologies are also available in 

VINcoSIM. Because VINcoSIM also relies on these individual functional topologies when 

performing calculations, users can be assured that PLECS and VINcoSIM are compatible in 

terms of their simulation results. 

 

 

Figure 6: Power module level circuit with functional topology-based simulation in VINcoSIM 

Functional topology-based modeling has its limitations, particularly when functional 

topologies are split between multiple power module packages. While, in such a scenario, 

the functional topologies successfully reproduce the electrical behavior, they fail to capture 

the thermal properties.  
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In the case of split functional topologies, it is, therefore, advisable  

to build the topology using individual switch and diode circuit elements and manually draw 

all the required connections. Furthermore, the thermal description of each semiconductor 

must be created manually based on the module datasheet. 

The Vincotech PLECS topology library can be downloaded from the Vincotech website and 

is available in the VINcoSIM simulator. A detailed guide about where to find it and how to 

install it into PLECS is provided in a later chapter. 

 

5 Modeling Semiconductor Characteristics 
 

The characteristics of the semiconductors used in the power module must be considered 

to perform a representative electrothermal simulation. These characteristics describe the 

electrical and thermal behavior of each semiconductor within the specific power module 

package. 

There are three types of semiconductor characteristics for power modules: 

• Static characteristics, which define conduction losses. 

• Dynamic characteristics, which define switching losses. 

• Thermal characteristics, which define the thermal connectivity (thermal chain) 

between the semiconductor and the power module package case. 

 

  

Figure 7: Static characteristics   Figure 8: Dynamic characteristics Figure 9: Thermal characteristics 
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Static and dynamic characteristics depend on the temperature; additionally, dynamic 

characteristics depend on the gate resistance, Rg.  

Each Vincotech power module’s static, dynamic, and thermal characteristics are available 

in the Vincotech product datasheets and the VINcoSIM web-based simulation tool. 

PLECS uses the same characteristics to simulate losses and temperatures. These can be 

defined in PLECS as thermal descriptions, either by manually entering datasheet values or 

by referring to a thermal descriptor .xml file. 

The thermal descriptor .xml file provides a much easier and faster approach than manual 

definition. In addition to the datasheet, Vincotech provides the characteristics in .xml 

format, which can be downloaded via the VINcoSIM simulator. 

When no thermal descriptors are provided, PLECS simulates ideal components without 

considering electrical losses and thermal conductivity.  

PLECS requires a thermal descriptor to simulate real conditions, including thermal 

conduction and switching losses. Once provided, the thermal network is excited and the 

simulation engine calculates the temperature increase caused by losses on the 

semiconductors.  

The same method is relied on to simulate the power module as a whole. The only 

difference is that, in this case, the thermal package comprises more than one 

semiconductor. 

 

Figure 10: The calculation loop used by PLECS to determine the electrothermal behavior of a power 

module with an IGBT and a diode. 
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The simulation is left to run until the temperature swing reaches a steady state, reflecting 

the temperatures at continuous operation under specified application and simulation 

parameters. Achieving VINcoSIM comparable results in PLECS requires to perform a 

steady-state analysis. 

 

6 Relationship Between the Topology Model and the 

Semiconductor Characteristics 
 

As described in the previous chapter, modeling a power module in PLECS requires an 

electrical circuit or a topology model and semiconductor characteristics. Vincotech provides 

topology models as functional topologies and publishes semiconductor characteristics in a 

PLECS-compatible thermal descriptor .xml file format. 

To run an electrothermal simulation in PLECS, the topology and characteristics must be 

commissioned before starting the simulation. This involves assigning the correct thermal 

descriptor to the corresponding functional topology. 

IMPORTANT: Vincotech thermal descriptors in .xml files are related to specific functional 

topologies. They are only fully operational when applied to the relevant Vincotech 

functional topology and cannot be loaded onto other functional topologies or circuit 

elements.  
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7 How to import VINcoSIM models to PLECS 
 

Vincotech power modules can be simulated in PLECS in just five simple steps.  

 

1. Download the Vincotech library (Guide: steps 1 – 7)  

Download the library here: https://www.vincotech.com/support-and-

documents/simulation-software.html  

 

  

https://www.vincotech.com/support-and-documents/simulation-software.html
https://www.vincotech.com/support-and-documents/simulation-software.html
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2. Add the relevant functional topologies from the Vincotech Library.  

(Guide: steps 8-10) 

 

 

 

3. Reconstruct the power-module-specific circuit. (Guide: steps 11-12) 
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4. Download the thermal .xml file from VINcoSIM (Guide: steps 13-14) 

 

 

 

5. Assign the thermal .xml files to each functional topology (Guide: steps 15) 

 

 

 

The following chapter provides a step-by-step tutorial that guides users through the entire 

process of running simulations with Vincotech power modules in PLECS, starting from 

scratch. 
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8 Step-by-step User Guide on Using Vincotech PLECS 

Models 
 

The following paragraphs outline the steps required to assign models in PLECS using 

Vincotech topology models and .xml thermal descriptors. They explain in detail how to 

download models and install them in PLECS so that they are ready for use by PLECS end 

users. 

 

8.1 Vincotech PLECS Library 
 

The Vincotech library includes several functional topology models, which are the basic 

building blocks needed to model power modules. First, the library must be downloaded 

and installed in PLECS. It can be downloaded from the VINcoSIM webpage as a compressed 

zip folder. 

Link to the webpage: 

https://www.vincotech.com/support-and-documents/simulation-software.html  

 

  

https://www.vincotech.com/support-and-documents/simulation-software.html
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This webpage can be reached directly from www.vincotech.com by accessing the Support 

& Documents menu and selecting Simulation Software VINcoSIM. 

 

 

This page can also be accessed from VINcoSIM by clicking on the Characteristics & 

Models menu and selecting Vincotech PLECS Library. 
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Step 1:  

On the Simulation Software VINcoSIM webpage, select Download Vincotech PLECS 

Library to download the library .zip file. 
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Step 2: 

Extract the Vincotech_Library.zip file to a designated folder. Choose the folder 

intentionally, as it will need to be linked to PLECS. Later, the thermal descriptor .xml files 

will also need to be copied into this folder structure. 
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Step 3: 

After creating the folder and extracting the library, install it into PLECS. The installation 

steps are also described in the install.txt text file in the extracted folder structure. 

 

 

 

 

Step 4: 

To install the library, open the PLECS Library Browser and select PLECS Preferences 

from the File menu. 
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Step 5: 

At the PLECS preferences window, select the Thermal tab and add the extracted library 

by clicking the + button. 

 

 

Step 6: 

In the Select Directory window, browse to the directory where you extracted the .zip file, 

navigate to the Vincotech_Library\plecs\Library folder, and click the Select Folder 

button. 
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Step 7.  Restart the PLECS application. If you executed all steps correctly, the Vincotech 

Library will appear in the PLECS Library Browser, displaying the 2-Level and 3-Level, 

topology sections. 

 

 

The Vincotech Topology Library in PLECS is ready to use. Select the desired functional 

topology from the library browser to add it to your simulation setup. 
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8.2 Simulate Vincotech Power Modules in PLECS 
 

Once you have installed the Vincotech PLECS library, you can simulate a specific Vincotech 

power module. The following steps are required to set up the simulation correctly: 

1. Add the functional topologies from the Vincotech library. 

2. Reconstruct the power module specific circuit by adding connection wires between the 

functional topologies. 

3. Download the thermal descriptor .xml files for the functional topologies from VINcoSIM. 

4. Assign the thermal descriptions to the corresponding functional topologies.  

The following example guides you through these steps to help you correctly set up your 

PLECS simulation. 

 

Step 8: 

Find the product you want to simulate in PLECS on the Vincotech website under the 

Products menu. Use the built-in filters to find your desired product easier.  

Select the product from the list view and open VINcoSIM by clicking Simulate. 
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Alternatively, launch VINcoSIM for the selected product by clicking the Simulate this 

module button at the bottom of the product webpage. 
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Step 9: 

The product related VINcoSIM webpage opens. Next, add the functional topologies that 

are used in the product. The VINcoSIM webpage structure will help you identify the 

relevant functional topologies. 
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Step 10: 

Use the library browser in PLECS and the Vincotech library elements to add the desired 

functional topologies to the simulation page. 
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Step 11: 

After placing the functional topologies, it is important to reconstruct the module-specific 

circuit by adding wire connections between the functional topologies. 
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Step 12: 

The final step before assigning the thermal model is to add a shared heatsink to the circuit 

and connect it to a grounded thermal source. This heatsink, which could be the power 

module backside copper or the baseplate, integrates the circuit into a thermally equivalent 

package. 

 

 

 

This makes the simulation model setup ready for the next step: assigning a thermal 

description to each functional topology. 
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Step 13: 

To assign a thermal description to each functional topology block, download the relevant 

.xml files from VINcoSIM. In VINcoSIM, click on Characteristics & Models, located below 

the related functional topology. In the sidebar that opens, click on PLECS Thermal Model 

to download the .xml file for this product and functional topology. A green bar in VINcoSIM 

will indicate that the download is complete. If an error occurs during the file export, 

information about the causes will be provided in an error message. 

 

 

Repeat these steps to download the .xml files for all functional topologies for the selected 

power module. In the end, the number of .xml files should equal the number of functional 

topologies in the product. 
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The .xml filenames include the product name (e.g., B0-SP12PMA100M7-LQ99A78T) and 

the designation of the relevant functional topology (e.g., Typical Sixpack). 

 

 

Step 14: 

Copy these .xml files to the correct subdirectory in the Vincotech PLECS library folder. To 

do so, navigate to the folder where you unzipped the Vincotech PLECS library. 

The topology folders are in the following folder structure:  

  VincotechLibrary\plecs\Library\VincotechThermalDescriptions\Vincotech 

Copy the downloaded .xml files to the right folder, referring to the .xml filenames.  

For example, copy the B0-SP12PMA100M7-LQ99A78T_4701_3_Typical Sixpack 

model.xml file to the Sixpack folder. 
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Step 15. Click the Refresh button on the Thermal tab in PLECS Preferences to see 

changes in the library. 

 

Step 16: 

To assign a thermal model to a Vincotech functional topology, double-click on that and 

then select the appropriate thermal model by clicking on From library. 
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Follow these steps for all functional topologies in the order presented. If a folder contains 

multiple models, they will also be available in the list. After selecting the model, define 

additional parameters such as Rgon and Rgoff in the dialog window. 

 

 

Be sure to carefully select the models related to the same product if the power module 

package comprises more than one functional topology. 

 

After this step, the power module model set-up is complete.  
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Step 17: 

Before running a simulation with the model, initialize the simulation parameters. To do so, 

open this dialog in PLECS by entering the Simulation menu and selecting Simulation 

parameters. 

 

 

In the pop-up dialog, select the initialization tab and set up your simulation initialization 

and model parameters. 

 

With this step, you are ready to run your simulation. 
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Step 18: 

To simulate the losses, efficiency, and temperature of a power module, run a steady-state 

analysis. For this, open the Simulation menu and select Analysis tools. 

 

 

In the pop-up dialog window, define the steady-state analysis parameters. When you are 

ready, click Start analysis to run the simulation. 
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When the simulation is complete, the results can be displayed using standard PLECS tools, 

including the probe, scope, or switch loss calculator functions. The electrothermal behavior 

of the Vincotech power module is represented in the simulation results, e.g., in the 

temperature swing on the semiconductors displayed below.  
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9 Summary 

 

This tutorial offers step-by-step instructions on how to simulate Vincotech power modules 

in a PLECS environment.  

PLECS software is supported by Plexim. The Vincotech library and VINcoSIM generated 

.xml files are supported by Vincotech.  

If you identify a problem with the Vincotech Library or a VINcoSIM .xml file, please get in 

touch with your local Vincotech sales support representative.  

If you encounter problems with the PLECS software (e.g., convergence, probing 

difficulties, etc.), please reach out to your dedicated PLEXIM support. 
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